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Resources  
The Resources User Manual explains how to use the Resources module to collect and manage 
resource information for an incident. The primary purpose of the Resources module is to provide a 
standardized method to check-in resources when they arrive at an incident. This makes record keeping 
and status assessment easier. 
  
Resources also produces various incident reports, including the 209 Report, Section Report, 
Qualifications Report, and Daily Incident Reports.  
  
Information entered in Resources is shared with other I-Suite modules, including: 
  

• Demob 

• Incident Action Plan (IAP 

• Time 

• Cost 

• Supply 

• Injury/Illness 
  
Topics in this guide include the following: 
  

• Common Features (See Page 5) 

• Selecting Resource Options (See Page 9) 

• Filtering Resource Data (See Page 12) 

• Common Data (See Page 14) 

• Managing Data and Resources (See Page 19) 

• Printing T-Card Labels (See Page 26) 

• Printing Plans Reports (See Page 27) 

• Plans Report Descriptions (See Page 37) 
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Common Features 
This section describes the menus and toolbars available in the Resources module. 

Menus 

The following drop-down menus display at the top of the I-Suite windows:  
  

File Menu 
The following options are available in the File menu in all modules: 
  

• Open Database - Opens an incident database in I-Suite. 

• Print - Prints the grid in the open module or a report selected on the Reports 
window. 

  

The Print option is not available in the Database Admin module. 

  

• Refresh Data - Refreshes the data on your window. 

• Exit - Closes the I-Suite application. 
  

Modules Menu 
The following options are available in the Modules menu: 
  

• Database Admin - Opens the Database Admin Module. 

• Data Admin - Opens the Data Admin Module. 

• Resources - Opens the Resources Module. 

• Cost - Opens the Cost Module. 

• Supply - Opens the Supply Module. 

• IAP - Opens the Incident Action Plan Module. 

• Demob - Opens the Demob Module. 

• Time - Opens the Time Module. 

• Injury/Illness - Opens the Injury/Illness Module. 
  

Filters Menu 
Select an option from the Filters drop-down menu to filter the Resources grid by:  
  

• Aircraft  

• Crews  

• Equipment  

• Overhead  

• All  
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• All Personnel  
  
  

Reports Menu 
Select an option from the Reports menu to print the following types of reports: 
  

• Cost Reports  

• Demob Reports  

• Plans Reports  

• Supply Reports  

• Time Reports  

• Custom Reports  

• Injury/Illness Reports 
  

Tools Menu 
The following options are available in the Tools menu in all modules: 
  

• Options - Define the settings for the different modules in I-Suite. 
  

The settings you can change in Options depends on the permissions that are assigned to you in the I-
Suite system. 

  

• Quick Stats - Quickly view Stats in the I-Suite system. 

• Change Password - Change your I-Suite password. 
  
  

Help Menu 
The following options are available in the Help menu: 
  

• I-Suite Help - Opens Help information for the I-Suite application. 

• About - Displays version information for I-Suite. 

• Support - Displays contact information for the HelpDesk. 
  

Toolbars 

The following toolbars display at the top of the I-Suite windows: 
  

Main Toolbar 
The Main toolbar contains two separate types of buttons: 
  

Module Buttons 
The Module buttons open modules in the I-Suite system. These buttons are located on the left side of 
the Main toolbar. The following example identifies the buttons and the modules that they open: 
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Action Buttons 
The Action buttons perform an action in one of the I-Suite modules. These buttons are located on the 
right side of the Main toolbar. The following example identifies the buttons and the action that occurs: 

  

 

Filter Toolbar 
The Filter toolbar displays beneath the Main toolbar. Click the buttons in this toolbar to filter the 
information in the Resources grid. The following example identifies the buttons in this toolbar and the 
resources that display in the grid when you click the buttons: 
  

 
  
  

Resources Toolbar 
The Print T-Card Labels button displays to the right of the Filter toolbar when you are in the Resources 
module. Click this button to print T-Card Labels. The following is an example of this button: 
  

 
 
 
The Group Check-In and No Grouping buttons display to the right of the Print T-Card Labels button 
when you are in the Resources module. Click the C button to open the Manage Resources window and 
select the users to check-in as a group. Click the N button to turn off the grouping option.  
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Selecting Resource Options 

Follow the steps in this section to select the options to use in the Resources area of the I-Suite system: 
  

1. From the Tools drop-down menu, select Options to open the Options window.  

2. Click the Resources tab. 

3. Click the lower Resources tab. 

 
  

4. Under Resource Grid Columns, hold down the Ctrl key and click to highlight 
each of the columns you want to select.  

5. If you want to remove the selected columns from the Resource grid, click the 
Hide button. 
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If you want to display the selected columns in the Resource grid, click the Show 
button. 

Each column with a checkmark in the checkbox next to it is included in the grid. When you click the Show 
button, it places a checkmark in the checkbox next to the selected column. When you click the Hide 
button, it removes the checkmark from the checkbox. You can also click the checkbox next to a listed 
column to either Show or Hide it. 

  

6. To adjust the order in which the columns display in the Resource grid, click a 
column listed under Resource Grid Columns. Then click the Move Up or Move 
Down button to move the column. 

The order in which the columns display under Resource Grid Columns is the order in which they will 
display in the grid. 

  

7. If you want to change the titles that display for the Other columns, type the new 
name in the "Other" Column Titles box. For example, to change the name of the 
Other 1 column, enter the new name in the box next to Other 1. 

When the title for the Other columns are changed on the Resources tab, the changes are saved to the 
database. This means that all users will see the changes. 

  

8. If you want to automatically insert the system date and time for the check-in, click 
the System Date option in the Default Check-In Date and Time area.  
 
If you want to leave the check-in date and time blank, click the Blank option in the 
Default Check-In Date and Time area. 

Each user can define the Default Checkin Date and Time they want to use in I-Suite. 

  

9. To add additional Kind Codes for Quick Stats, select the code from the 
Kind/Position drop-down list. Then click the Save button. 
 
To remove Kind Codes for Quick Stats, click the code listed in the Additional 
Kinds used for Quick Stats box. Then click the Delete button. 

When you add additional Kind Codes for Quick Stats, the changes are saved to the database. This 
means that all users will see the changes. 

  

10. When you have made all of your changes, click the Save button to save any 
changes. Click the OK button to close the Options window. 

Defining Resource Label Parameters 
Follow the steps in this section to define the parameters for Resource Labels: 
  

1. From the Tools drop-down menu, select Options to open the Options window.  

2. Click the Resources tab. 
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3. Click the Labels tab. 

 
  

4. From the Special Purpose Label Printer drop-down list, select the label printer to 
use. 

5. In the First Fontsize box, type the font size to use for the first line on the label. 

6. In the Second Fontsize box, type the font size to use for the second line of the 
label.  

7. In the Top Offset box, type the print offset to use at the top of the label. This 
identifies the amount of space to insert at the top of the label. Use this option, 
along with the Left Offset option, to define where to print the text on the label. 

8. In the Left Offset box, type the print offset to use on the left side of the label. This 
identifies the amount of space to insert on the left side of the label. Use this 
option, along with the Top Offset option, to define where to print the text on the 
label. 

9. From the Font Name drop-down list, select the type of font to print on the label. 

10. Click the OK button to save any changes made to the label settings. 
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Filtering Resource Data 
This section explains how to filter Resources data. You can search for specific characters in any column.  

Filtering Data Using the Filter Bar 

Follow the steps in this section to use the Filter Bar to filter data in the Resources grid: 
  

1. Click the Resources button to open the Resources window.  

2. In the Filter Bar above the grid, enter a term to search for that specific item in the 
grid. The filter boxes are located directly above the Resources grid and 
correspond to the columns over which they display. 
 
For example, you can search for any name that begins with the words air by 
typing AIR in the Filter box above the Name column heading.  

 
2. Type the first several characters of the search term in the Filter box to narrow 

your search. 

3. To remove the filter, either delete the characters that you typed or click the Clear 
Filter Bar button that displays to the left of the Filter bar. 
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Filtering with the Exclude Demobed Option 

To remove resources with a Demobed status from the Resources grid, click to check the Exclude 
Demobed checkbox. 
  

Filtering with the Exclude Filled Option 

To remove resources with a Filled status from the Resources grid, click to check the Exclude Filled 
checkbox. 
  

Using Filter Buttons 

1. Open the Resources window. 

2. Click one of the following buttons to only display those types of records:   

• All Resources  

• Aircraft  

• Crews  

• Equipment  

• Overhead 

• All Personnel  
When the All Personnel filter is selected in Resources, you cannot Add or Edit resources. The Add and 
Edit buttons in the Main toolbar are disabled. 

  

Sorting with Table Column Headings 

1. Open the Resources window, 

2. In the Resources grid, click the column heading you want to use to sort the 
information in the grid. For example, if you click the Name column heading, the 
information is sorted in Name order. 

3. Click the heading once to sort the information in Ascending order. Click the 
heading a second time to sort in Descending order. 

To use multiple columns to sort the data in the grid, hold down the Shift key and click each column 
heading you want to include in the sort. 
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Common Data 
This section explains how to review and edit common data in the Resources module. Information that 
displays above the Plans tab In the Manage Resource - Edit Mode area is considered the Common 
Data for a Resource.   
  

Reviewing Common Data 

Follow the steps in this section to review common data for a resource: 
  

1. Click the Resources button to open the Resources window. 

2. In the Resources grid, click to select the Resource you want to review. 
NOTE:  The supply column will display a checked box is the resource or subordinate resource has 
outstanding supply items 
 

 

3. Click the Edit button in the Main toolbar at the top of the window or double click 
the selected Resource to display the Manage Resource - Edit Mode area at the 
bottom of the window: 
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4. Review the following information for completeness and accuracy: 

ROSS Import data will follow ROSS data standards. ROSS information that is imported into I-Suite 
includes Resource Name, Request Number, and Mob Date. It may also include Agency, HomeUnit, 
KindCode, and JetPort, if they are defined in ROSS.  
 
Make sure you check the imported ROSS information at check-in for accuracy. There may be incorrect or 
missing data. Also check Crew Rosters with the CRWB. 

• *Request Number 

• *Account Code 

• Person - checked, if applicable 

• Contracted - checked, if applicable 

• *Resource Name 

• Cell Phone 

• *Kind/Position 

• Trainee - checked, if applicable 

• *Status 

• Unit ID 

• Agency 

• *Configuration 

• Actual Release Date 

• Actual Release Time 

A field label preceded by an asterisk (*) indicates that the information is required.  
 
When the Person option is checked, the Resource Name text box is replaced with Last Name and First 
Name text boxes and an Other Quals area displays on the Plans tab. Either a Last Name OR a First 
Name is required for a person. You do not need to define both in order to save the record. 

  

5. To close the Manage Resource - Edit Mode window, click the Close button. 

  

Editing Common Data 

After reviewing the Common Data for a Resource on the Manage Resource - Edit Mode window, you 
can edit the information, as needed. Follow the steps in this section to edit the information: 
  

1. Click the Resources button to open the Resources window.  

2. If you want to edit a resource, click the resource in the Resources grid, then click 
the Edit button or double click the resource.  

3. In the Request Number box, enter the request number for the resource. 
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4. From the Account Code drop-down list, select the accounting code to assign to 
the resource. 

5. If the resource is a person, click to check the Person checkbox.  

If you change the Person selection and time was posted for the resource, a message displays indicating 
that the time postings will be deleted if you continue. When you select Yes, the system deletes all time 
postings. When you select No, the system does not change the Person selection. 

  

If you change the Person selection and one or more invoices were already generated for the resource, a 
message displays indicating that the resource has invoiced postings. You must manually delete those 
postings before you can change the Person selection. 

  

6. If the resource is contracted, click to check the Contracted checkbox.  

If you change the Contracted selection and time was posted for the resource, a message displays 
indicating that the time postings will be deleted if you continue. When you select Yes, the system deletes 
all time postings. When you select No, the system does not change the Contracted selection. 

  

If you change the Contracted selection and one or more invoices were already generated for the 
resource, a message displays indicating that the resource has invoiced postings. You must manually 
delete those postings before you can change the Contracted selection. 

  

7. If the resource is equipment or a crew, enter the Resource Name. 
 
If the resource is a person, enter the person's Last Name and First Name.  

Either a Last Name or a First Name is required. You do not need to enter both in order to save the 
record. 

  

8. Enter the resources Cell Phone. 

9. From the Kind/Position drop-down list, select the kind code or position code for 
the resource.  

10. If the resource is a person who is a trainee, click to check the Trainee checkbox.  

11. From the Status drop-down list, select the status of the resource. The following 
status codes are available: 
 
C - Checked-In 
D - Demobed 
F - Filled/Not Checked-In 
P - Pending Demob 
R - Reassigned 
S - Staging 

12. From the Unit ID drop-down list, select the Unit ID to assign to the resource. 

13. From the Agency drop-down list, select the Agency for the resource. 
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14. From the Configuration drop-down list, select the configuration for the resource. 
The following configurations are available: 
 
S - Single Resource 
S/T - Strike Team 
T/F - Task Force 

15. When applicable, enter the Actual Release Date for the resource. 

When the D Status is selected, the Actual Release Date is required. 

  

15. When applicable, enter the Actual Release Time for the resource. 

16. To save any changes to the Common Data, click the Save button. 

17. To close the Manage Resource - Edit Mode window, click the Close button. 
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Group Check-In for Multiple Resources 
This section explains how to perform Check In for multiple resources utilizing Group Check-In. 
  

1. In the Resource's grid, select the resources for which you want to change the 
status to Checked-In. 

2. Click the C button on the toolbar. This opens the first selected resource in Edit 
mode and defaults the status to C (Checked-In). 

 

3. Click the Save and Next button. Each time you click the Save and Next button, 
the system saves the status change and any other changes made to the 
resources information. The system then automatically moves to the next selected 
resource and defaults the status for that resource to C. 
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Managing Data and Resources 

This section explains how to use the Resources module to add and manage data.  
  

Adding Resources Using ICS 211 or Check-In Form 

Follow the steps in this section to add resource items such as Aircraft, Overhead, Crews, and Equipment 
using an ICS 211 or optional Check-In form: 
  

1. Click the Resources button in the toolbar to open the Resources window. 

2. Click the Add button in the Main toolbar to add a new resource. A Manage 
Resource - Add Mode area displays at the bottom of the window when you click 
this button: 

 
  

3. In the Manage Resource – Add Mode area, enter or select the following 
information, as appropriate. (See Editing Common Data on Page 15) 

• *Request Number 

• *Account Code 

• Person - checked, if applicable 

• Contracted - checked, if applicable 

• *Resource Name 

• *Kind/Position 

• Trainee - checked, if applicable 

• *Status 
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When the D status is selected, the Actual Release Date is required. 

  

• Unit ID (Optional) 

• Agency (Optional) 

• *Configuration 

• Actual Release Date (Optional) 

• Actual Release Time (Optional) 

A label preceded by an asterisk (*) indicates that the information is required.  
 
When the Person option is checked, the Resource Name box is replaced with Last Name and First 
Name text boxes and an Other Quals box displays. Either a Last Name OR a First Name is required for 
a person. You do not need to define both in order to save the record. 

 

The Agency and Unit ID are important fields, but they are not required. Entering incorrect data in these 
fields is worse than having no data defined. An incorrect Agency code will generate incorrect Cost data.  

  

4. On the Plans tab, complete the following information, as needed: 

The Plans tab only displays at the bottom of the Resources window if the user has Resource rights. 

  

• Check-In Date 

When the Check-In Date is more than 5 days prior to the system date, a warning message will be 
displayed.  

• Check-In Time 

• Num Personnel 

• Demob City 

• Demob State 

• Jetport 

• Travel Method 

When selected Travel Method is A/R or AIR, the Travel Questions button will be visible.  

• Travel Questions 

To answer Travel Questions, click the Travel Questions button that displays beneath the Travel Method 
box. If the answer to a question is Yes, click to check the checkbox next to the question. Enter the 
Resource's name found on their Picture ID in the Name on Picture ID box (required for Air travel). Click 
the Save button to save the responses to the Travel Questions. 

  

• Mobilization Date 

• First Work Day 

• Length of Assignment (Days) 

• Other (1, 2, & 3) 

• Vehicle ID 
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• Original Order/Request Number 

• Incident Card # 

The Incident Card # is only applicable for the Supply Pilot Release. If your team is currently part of the 
Supply Pilot, you can either enter the incident card number for a resource into the Incident Card # box or 
scan the number on the resource's incident card. If you enter the number, you only need to enter the 
actual numeric digit. You do not need to enter any leading zeros or the underscore and letter at the 
beginning of the number (e.g., for the number _P000000004, you would only need to enter 4). 

• Plans Remarks  

5. To enter Other Quals for a person, move to the Other Quals area on the Plans 
tab: 
 

 

a. Select a kind code from the Kind Code drop-down list.  

b. If the person is a trainee for the selected kind code, click the Trainee option. 

c. To save the Other Quals you defined, click the Save Quals button.  

d. To delete the Other Quals you defined, click the Delete Qual button. 

6. Click the Save button to save the resource. 

7. When the Data Saved window displays, click the OK button to close the window. 

  

Rostering a Resource  

To roster a resource, complete the following steps: 
  

Resources cannot be rostered to a person. 

  

1. Click the Roster button at the bottom of the window. 
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2. In the Roster Resource – Add Mode area, enter the appropriate information 
for the person being rostered to the resource including: 

• *Request Number  

• Leader checkbox (Optional)  

• *Last Name  

• *First Name  

• *Kind/Position  

• Trainee checkbox (Optional)  

• *Status  

When the D status is selected, the Actual Release Date is required. 

  

• Unit ID (Optional) 

• Agency (Optional)  

• Actual Release Date (Optional)  

• Actual Release Time (Optional)  

• *Time information  

3. On the Plans tab, complete the following information, as needed: 

• Check-in Date 

• Check-in Time 

• Demob City 

• Demob State 

• Jetport 

• Travel Method 

• Mobilization Date 

• First Work Day 

• Length of Assignment (Days) 

• Demobilization Date 

• Other 1 

• Other 2 

• Other 3 

• Vehicle ID 

• Original Order/Request Number 
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• Incident Card # 

The Incident Card # is only applicable for the Supply Pilot Release. If your team is currently part of the 
Supply Pilot, you can either enter the incident card number for a resource into the Incident Card # box or 
scan the number on the resource's incident card. If you enter the number, you only need to enter the 
actual numeric digit. You do not need to enter any leading zeros or the underscore and letter at the 
beginning of the number (e.g., for the number _P000000004, you would only need to enter 4). 

  

• Plans Remarks 

• Other Quals 

4. On the Time tab, enter the appropriate information for the person being 
rostered to the resource. 

The Time tab only displays if the user has Time rights . For more information about adding Time data, 
refer to the section, Defining Personnel Time, in the Time User Guide. 

  

Click the Members to Fed button to automatically assign an Employment Code of Fed to any rostered 
person who does not have an Employment Code assigned. 
 
You can change the Members to Fed button to the Members to Other button by clicking the arrow next 
to the button and selecting Other from the list that displays. When you click the Members to Other 
button, an Employment Code of Other is assigned to any rostered person who does not have an 
Employment Code assigned. 

  

5. On the Cost tab, enter the appropriate information for the person being 
rostered to the resource. 

The Cost tab only displays if the user has Cost rights.  
 For more information about adding Cost data, refer to the section, Cost Resources, in the Cost User 
Guide. 

  

6. After the appropriate information is defined, click the Save button to save the 
Roster information. 

  

Creating a Strike Team/Task Force Parent Record 

There are two methods you can use to create a strike team/task force.  
  

• Use the first method when a group of resources not currently defined in the 
database is ordered as a strike team/task force(See Method 1 - Attach Strike 
Team/Task Force to Parent Record on Page 24).  

• Use the second method when assembling a strike team/task force from resources 
that already exist in the I-Suite database(See Method 2 - Attach Existing 
Resources to Strike Team/Task Force on Page 25).  

Both methods require you to create a parent record or place holder. You will then need to add or attach 
the strike team/task force components to the parent record. Follow the steps in this section to create the 
parent record for the strike team or task force: 
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1. Click the Resources button in the toolbar to open the Resources window.  

2. Click the Add button to add a new record. 

3. On the Manage Resource – Add Mode window, enter the appropriate 
information, including ALL required information. (See Editing Common Data on 
Page 15) 

• When selecting the Kind/Position, select a type applicable to the type of 
Strike Team (e.g. select “ES3” for a type 3 strike team). 

• When selecting the Configuration, select S/T. Notice that the label 
Manage Resources – Add Mode has now changed to Add Strike 
Team / Task Force. The Roster button is replaced with two new 
buttons for adding components. 

 

• If tabs display at the bottom of the window (Plans, Time, Cost), complete 
the information, as appropriate. 

4. To complete the Strike Team/Task Force parent record, continue with Method 1 - 
Attach Strike Team/Task Force to Parent Record (See Page 24) or Method 2 - 
Attach Existing Resources to Strike Team/Task Force (See Page 25). 

  

Method 1 - Attach Strike Team/Task Force to Parent Record 

Use Method 1 to add strike team or task force components that do not already exist in the I-Suite 
database. 
  

If you add the strike team leader last, you will not have to change the kindcode.  

  

1. On the Resources window, click the Add New Component button.  

The Add New Component button only displays when S/T or T/F is selected in the Configuration field. 

  

2. When the message displays indicating that you must save the resource to add the 
component, click Yes to save the parent record.  

3. When the Data Saved message displays, click the OK button to display the Add 
New Strike Team/Task Force window.  

4. On the Add New Strike Team/Task Force Component window, complete the 
common information, as needed. (See Editing Common Data on Page 15) 

Configuration will default to C for component. 
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In the Num Personnel box, type the total number of people on the strike team component. 

  

5. If the Plans tab displays at the bottom of the window, complete the information, as 
needed. 

6. Roster crew members, as needed. 

7. To save the Strike Team/Task Force Component after entering the appropriate 
information, click the Save button. 

8. On the Data Saved message box, click the OK button. 

9. Continue adding components, as needed. 

10. After adding the final component, click the Close button. 

Several boxes are completed by I-Suite based on the parent record. Review this information for accuracy. 
Also, make sure to change the kind code when rostering people, if needed.  

  

Method 2 - Attach Existing Resources to Strike Team/Task Force 

Use Method 2 to add strike team or task force components that already exist in the I-Suite database. 
Follow the steps in this section to use Method 2 to add strike team or task force components to a parent 
record: 
  

1. On the Resources window, click the Add Existing Resource/Remove 
Component button. 

2. When the message displays indicating that you must save the resource to add the 
component, click Yes to save the parent record. 

3. When the Data Saved window displays, click the OK button to display the Add 
Existing Strike Team/Task Force Components window.  

4. On the Add Existing Strike Team/Task Force Component window, click a 
resource listed in the grid. Then click the Add button to add the resource to the 
Strike Team/Task Force.  

5. Repeat step 4 for each resource you want to add to the Strike team/Task Force. 

If you want to remove a resource that was added to the Strike/Team Task force, click the resource in the 
grid at the top of the window. Then click the Remove Component(s) button that displays beneath the 
grid. 

  

6. After adding all of the appropriate components to the strike team/task force, click 
the Close button. 
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Printing T-Card Labels 
Follow the steps in this section to print T-Card labels.  
  

1. Click the Resources button to open the Resources window.  

2. In the Resources grid, click the resource for which you are creating the T-Card.   

3. Click the T-Card button in the toolbar. The T-Card Label is sent to your default 
printer. 
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Printing Plans Reports 
Follow the steps in this section to print Plans Reports for resources:   
  

1. Click the Reports button in the toolbar at the top of the window. The Plans 
Report window displays.  

2. Click one of the following options to identify the type of information you want to 
include on the report: 

• Aircraft Report (See Aircraft Report on Page 27) 

• Crew Report (See Crew Report on Page 29) 

• Equipment Report (See Equipment Report on Page 30) 

• Overhead Report (See Overhead Report on Page 31) 

• 209 Resource List (See 209 Resource List on Page 32) 

• Qualifications Report (See Qualifications Report on Page 33) 

• Section Report (See Section Report on Page 34) 

• Strike Team/Task Force Report (See Strike Team/Task Force Report 
on Page 34) 

• Crew Roster Report 1391710565See Crew Roster Report  

  

Aircraft Report 

This report identifies the aircraft available for the incident. To generate an Aircraft Report, complete the 
following steps: 
  

1. On the Plans Report window, click the Aircraft Report option to display the 
Report Settings. 
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2. Under Select, click one of the following options to only include resources that 
meet that criteria: 

• Check-in, pending, staging 

• Demobed, reassigned 

• Pending demob 

• Not demobed 

• Filled 

• All resources 

3. Under Sort, double click to select the sorts to use when creating the report. Select 
the sort options in the order in which you want the information sorted.  

4. If you want to include the Strike Team/Task Force Components in the report, click 
to check the Include strike team/task force components checkbox. 

5. If you want to include sub-totals for the first sort that you selected, click to check 
the Subtotals on first sort checkbox. 

6. To preview and then print the report, click the Preview button. Then click the Print 
Report button.  

7. To print the report without previewing, click the Print button. 
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Crew Report 

This report identifies the crews available for the incident. To generate a Crew Report, complete the 
following steps: 
  

1. On the Plans Report window, click the Crew Report option display the Report 
Settings. 

 
  

2. Under Select, click one of the following options to only include resources that 
meet that criteria: 

• Check-in, pending, staging 

• Demobed, reassigned 

• Pending demob 

• Not demobed 

• Filled 

• All resources 

3. Under Sort, double click to select the sorts to use when creating the report. Click 
the sort options in the order in which you want the information sorted. 

4. If you want to include the Strike Team/Task Force Components in the report, click 
to check the Include strike team/task force components checkbox. 
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5. If you want to include sub-totals for the first sort that you selected, click to check 
the Subtotals on first sort checkbox. 

6. To preview and then print the report, click the Preview button. Then click the Print 
Report button.  

7. To print the report without previewing, click the Print button. 

  

Equipment Report 

This report identifies the equipment available for the incident. To generate the Equipment Report, 
complete the following steps: 
  

1. On the Plans Reports window, click the Equipment Report option to display the 
Report Settings. 

 
  

2. Under Select, click one of the following options to only include resources that 
meet that criteria: 

• Check-in, pending, staging 

• Demobed, reassigned 

• Pending demob 

• Not demobed 
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• Filled 

• All resources 

3. Under Sort, double click to select the sorts to use when creating the report. Click 
the sort options in the order in which you want the information sorted. 

4. If you want to include the Strike Team/Task Force Components in the report, click 
to check the Include strike team/task force components checkbox. 

5. If you want to include sub-totals for the first sort that you selected, click to check 
the Subtotals on first sort checkbox. 

6. To preview and then print the report, click the Preview button. Then click the Print 
Report button.  

7. To print the report without previewing, click the Print button. 

  

Overhead Report 

This report identifies the overhead personnel available for the incident. To generate an Overhead Report, 
complete the following steps: 
  

1. On the Plans Report window, click the Overhead Report option display the 
Report Settings. 
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2. Under Select, double click one of the following options to only include resources 
that meet that criteria: 

• Check-in, pending, staging 

• Demobed, reassigned 

• Pending demob 

• Not demobed 

• Filled 

• All resources 

3. Under Sort, double click to select the sorts to use when creating the report. Click 
the sort options in the order in which you want the information sorted. 

4. If you want to include the Strike Team/Task Force Components in the report, click 
to check the Include strike team/task force components checkbox. 

5. If you want to include sub-totals for the first sort that you selected, click to check 
the Subtotals on first sort checkbox. 

6. To preview and then print the report, click the Preview button. Then click the Print 
Report button.  

7. To print the report without previewing, click the Print button. 

  

209 Resource List 

This report contains ICS-209 information for Block 29 of the FAMWEB ICS 209 generated by the 
Situation Unit Leader.  
  

The 209 Report uses the number of people from the Strike Team/Task Force parent. 

  

When the Manage All Incidents as One option is selected, the 209 Resource List will include data for all 
incidents in the database. 

  
To generate the 209 Resource List, complete the following steps: 
  

1. On the Plans Report window, click 209 Resource List. 

2. To preview and then print the report, click the Preview button. Then click the Print 
Report button.  

3. To print the report without previewing, click the Print button. 
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Qualifications Report 

This report identifies the positions/kind codes defined in the I-Suite system and those resources that are 
assigned to the positions. To generate the Qualifications Report, complete the following steps: 
  

1. On the Plans Report window, click Qualifications Report to display the Report 
Settings. 

 
  

2. To include All Kinds in the report, click to check the All Kinds checkbox. 
 
To include specific kind codes in the report, double click the code you want to 
include to move it from the Kind Codes list to the Selected Kinds list. 

To search for a code listed under Kind Codes, enter the code in the Kind Search box. The application 
automatically highlights the code that matches your search term. Double click the kind code or click the > 
button to add it to the Selected Kinds list. 

  

3. If you do not want to include trainees in the report, click to check the Exclude 
Trainees checkbox. 

4. If you only want to include trainees in the report, click to check the Trainees Only 
checkbox. 

5. To preview and then print the report, click the Preview button. Then click the Print 
Report button.  

6. To print the report without previewing, click the Print button. 
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Section Report 

This report identifies those resources assigned to different sections (e.g. Command Staff, Operations 
Section, etc.). To generate a Sections Report, complete the following steps: 
  

1. On the Plans Report window, click Section Report display the Report Settings. 

 
  

2. Under Sort, double click to select the sorts to use when creating the report. Click 
the sort options in the order in which you want the information sorted. 

3. If you want to include the Strike Team/Task Force Components in the report, click 
to check the Include strike team/task force components checkbox. 

4. To preview and then print the report, click the Preview button. Then click the Print 
Report button. 

5. To print the report without previewing, click the Print button. 

  

Strike Team/Task Force Report 

This report identifies the Strike Teams and Task Forces currently defined in the I-Suite System. To 
generate a Strike Team/Task Force Report, complete the following steps: 
  

1. On the Plans Report window, click ST/TF Report to display the Report Settings. 
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2. Under Select, click the strike teams and task forces to include in the report. To 
include more than one strike team or task force, hold down the Ctrl key and click 
each one you want to include. To include all strike teams or task forces, click the 
Select All button. 

3. To preview and then print the report, click the Preview button. Then click the Print 
button. 

4. To print the report without previewing, click the Print button. 

  
Crew Roster Report 
This report identifies all crews currently defined in the I-Suite system. To generate a Crew Roster Report, 
complete the following steps: 
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1. On the Plans Report window, click Crew Roster to display the Report Settings. 
 

 

2. Under Select, click the crew(s) to include in the report. To include more than one 
crew, hold down the Ctrl key and click each one that you want to include. To 
include all crews, click the Select All button. 

3. To preview and then print the report, click the Preview button. Then click the Print 
button. 

4. To print the report without previewing, click the Print button. 
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Plans Report Descriptions 
The following Plans Reports are available in I-Suite: 
  

Aircraft Report 

This report identifies the aircraft available for the incident. You can print the report for: 
  

• aircraft that is checked-in, pending, or in staging, 

• demobed or reassigned aircraft, 

• aircraft pending demob, 

• aircraft that was not demobed, 

• filled aircraft assignments, 

• or all aircraft resources. 
  

Crew Report 

This report identifies the crews available for the incident. You can print the report for: 
  

• crews that are checked-in, pending, or in staging 

• demobed or reassigned crews, 

• crews pending demob, 

• crews that were not demobed, 

• filled crew assignments, 

• or all crew resources. 
  

Equipment Report 

This report identifies the equipment available for the incident. You can print the report for: 
  

• equipment that is checked-in, pending, or in staging, 

• demobed or reassigned equipment, 

• equipment pending demob, 

• equipment that was not demobed, 

• filled equipment assignments, 

• or all equipment resources. 
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Overhead Report 

This report identifies the overhead personnel available for the incident. You can print the report for: 
  

• overhead personnel that are checked-in, pending, or in staging, 

• demobed or reassigned overhead personnel, 

• overhead personnel pending demob, 

• overhead personnel that was not demobed, 

• filled overhead personnel assignments, 

• or all overhead personnel resources. 
  

209 Resource List 

This report contains ICS-209 information for Block 29. 
  

Qualifications Report 

This report identifies the positions/kind codes defined in the I-Suite system and those resources that are 
assigned to the positions. The information in this report includes: 
  

• the position and kind code, 

• the request number assigned to the resource, 

• the name of the resource assigned to the position, 

• identification of trainee resources, 

• the code for the agency assigned to the resource, 

• the section assigned to the resource, 

• and the demobilization date for the resource. 
  

Section Report 

This report identifies those resources assigned to different sections (i.e. Command Staff, Operations 
Section, etc.). 
  

ST/TF Report 

This report displays the Strike Team or Task Force and all the components within that Strike Team or 
Task Force. You can select one, multiple, or all Strike Teams and Task Forces.  
  

Crew Roster 

This report displays the Crew(s) and all the components within that Crew. You can select one, multiple, or 
all Crews.  
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Revision History 
Revision 
Date  

Revision Summary  

2011-03-02 Revised instructions for the 11.01.00 version of I-Suite. 
2010-04-27 Revised instructions for the 10.01.00 version of I-Suite. 
2009-05-01 Revised Instructions for the 9.01.00 version of I-Suite. 
2008-04-25 Revised instructions for the 8.01.00 version of I-Suite. 
2007-07-25 Revised instructions for the 7.01.05 version of I-Suite. 
2007-04-20 Revised instructions for the 7.01.00 version of I-Suite. 
2007-01-10 Revised instructions based on changes received for Training Manuals. 
2006-12-04 Revised instructions by adding more detail and graphics. 
2006-06-12 Added instructions for printing T-Card labels and revised instructions for the 6.02 version of 

I-Suite. 
2006-04-17 Revised instructions for the new I-Suite 2006 application. 
2005-02-28 Revised instructions for the new I-Suite website and to reflect changes in procedures from 

the June and August 2004 I-Suite releases. 
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